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1.0 – Introduction and Installation 

An IntegriSign plug-in allows you to create a document and sign it electronically with 
your handwritten signature using a Signature Capture Device. The plug-in facilitates: 

 

1. Signature Capture - The signature trace is captured and stored on the 
electronic document in a signature object. 

 
2. Content Hashing - The signature object is bound to the contents of the 

document such that any alteration of the document after signing it would render 
the signature invalid. 

 

3. Document Verification – The document can be verified to ensure its integrity 
(i.e., confirming that it has not been tampered) after the act of signing. 

 

1.1 – Before You Begin 
 

1. IntegriSign Desktop runs on Windows 7 operating systems and later. 
2. Your system should have a minimum of 50 MB free space on the hard drive, in 

addition to the free space requirements for Windows. 
3. Before installing a new version of IntegriSign Desktop, uninstall any older 

versions of IntegriSign Desktop on your machine. 
4. Close all the applications running on Windows. 

 

1.2 – Installing the ePad Device 
 

Refer to the manual provided by ePadLink for instructions on installing the device. 
Check if your computer recognizes the ePad. 

 

1.3 – Uninstalling IntegriSign Desktop 
 

To uninstall IntegriSign Desktop, go to “Start – Settings - Control Panel - 
Add/Remove” programs. You will find IntegriSign Desktop listed; select IntegriSign 
Desktop, and follow the instructions to uninstall the software. 

 
Signatures that have been placed into documents are not removed during 
uninstallation. 

 
Note: Deleting the IntegriSign Desktop installation folder directly will not uninstall the 
software completely. 
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2.0 – IntegriSign Desktop Preferences 

The IntegriSign Desktop Preferences window can be invoked from “Start – Programs 
– IntegriSign Desktop – Desktop – Preferences Manager”. IntegriSign Desktop 
Preferences facilitates the creation of profiles using the “Create” button. 

 

 
2.1 – IntegriSign Desktop – Configuration 

 

“Pen Color” and other details to be displayed along with the signature like “Name”, 
“Date”, “Logo”, and “Labels” for a public signer (no profile users) can be preset 
before creating a profile in the “IntegriSign Desktop - Desktop Configuration” window 
(“Start – Programs – IntegriSign Desktop – Desktop – Desktop Configuration”). 

 
You can also choose if “Anti-Aliasing” (technique used for signature smoothing) or 
“Thickness” needs to be used for signature drawing in documents. If “Thickness” is 
used, thickness value can be set. 

 
The size of the signature placeholder can be preset using the “Custom Signature 
Size” setting option from the “IntegriSign Desktop - Desktop Configuration” window. 
The default signature placeholder size is Width – 180 and Height – 110. 

 
The “Background Logo” option lets a user select the image that will be used as the 
logo to be displayed behind the signature. The width and height of the logo selected 
should not be more than 180 and 110 respectively. 

 
The “Signature Processing” section lets the user enable or disable white space 
removal for signatures and, if enabled, to specify the maximum enlargement factor. 
By default, the “White Space Removal” option is enabled (checked) and the 
“Maximum Enlargement Factor” is set to 1.25. 



IntegriSign Desktop User Manual 

6 

 

 

After signing on the signature pad with the “White Space Removal” option disabled, 
the signature pad sends the entire image of the drawing surface of the pad to the 
PC. When the “White Space Removal” option is enabled, the pad removes the white 
space around the signature drawn on the pad and sends only the rectangle that 
contains the signature information to the PC. Thus, when the PC displays the 
signature in a signature field in the document, the signature typically appears larger 
and more legible (compared to no white space removal), especially in the usual case 
where the signature field in the document is small. 

 
The “Maximum Enlargement Factor” option is used only in cases where the size of 
signature on the signature pad (after white space removal) is smaller than the size of 
the signature field in the document. When the signature drawn on the signature pad 
is smaller than the size of the signature field in the document, IntegriSign Desktop 
will enlarge the signature to fill the signature field. However, it will limit the 
enlargement to the value of the maximum enlargement factor. This prevents the 
signature from looking too pixelated or jagged. For example, the default width and 
height of the signature field in IntegriSign Desktop are 180 and 110 pixels, if not 
changed by the user. When translated into inches, the width is 1.875 inches and the 
height is 1.145 inches. If the signature field in the document is 4.0 inches wide and 
2.0 inches high, IntegriSign Desktop will enlarge the signature to fill the signature 
field, but limit the enlargement to the maximum enlargement factor. If the maximum 
enlargement factor is 1.50, then the signature in the document will be no more than 
50% larger than the signature captured on the signature pad. The maximum 
enlargement factor can range between 1.0 and 2.0. 

 
IntegriSign Desktop applies the current “White Space Removal” and “Maximum 
Enlargement Factor” settings set in the Desktop Configuration to all the signatures in 
a document signed using IntegriSign Desktop (including previously signed 
signatures) when the document is opened. Thus, suppose you have signed a 
document with the “White Space Removal” option disabled and saved the document. 
Later, if you enable the “White Space Removal” option and open the previously 
signed document, IntegriSign Desktop applies its “White Space Removal” technique 
to the previously signed signatures. Furthermore, if IntegriSign Desktop has enlarged 
a signature to fill a signature field, it applies the “Maximum Enlargement Factor” 
option as appropriate. 

 
The “Auto Select Signer Name from List” option selects a signer profile (if profiles 
exist) automatically in the signing window when checked. The functionality of this 
feature is that, if you have any profiles created using the “Preferences Manager”, the 
last created signer profile is automatically selected if this option is set in the “Desktop 
Configuration” window. The selected signer profile will be of the last used signer, if 
there are no profiles created between the last usage and current usage. If this option 
is turned off, the profile will not be selected by default when the signature capture 
dialog pops-up. 

 
The “Required Information” section allows you to make the “Signer Name” option 
mandatory for signing. 
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“ePad LCD” options allow the user to configure the ePad LCD devices (e.g. ePad- 
ink). The “Background Image” option lets the user select the image that needs to be 
displayed on the ePad LCD device during signature capture. Selecting “Default” 
displays the image that is selected in the ePad LCD device “Control Panel” applet 
(for ePad-ink, it is ePadInk-USB). Selecting “IntegriSign” displays an image with 
three buttons on the device: “OK”, “CLEAR”, and “CANCEL”. The functionality 
associated with these buttons is same as the buttons in the “Signature Capture 
Dialog”. 

 
The “Text to display below signature” option lets the user specify the text to be 
displayed on the ePad LCD Device below the signature capture region and above 
the “OK”, “CLEAR”, and “CANCEL” buttons. A maximum of two lines on the device 
can be used to display this text. If the device is an ePad-ink, the text can contain a 
new line character “\n” to wrap the text into two lines. If no “\n” is supplied, then the 
software wraps the text into two lines (if the text cannot be fit into one line). If the 
device is an ePad-vision, “\n” is not required, the text is sent to the device “as-is”, 
and the device displays the same in a text widget. 
 

 



IntegriSign Desktop User Manual 

8 

 

 

The “ePad-vision Options” section allows the user to specify if the compliance text 
options feature needs to be enabled. This feature is available only for ePad-vision 
devices. If the option “Enable compliance text options” is selected, the button 
“Options” gets enabled and you can choose the screens to be displayed during the 
act-of-signing. Clicking the “Options…” button will display the following window. 

 
 

 
By default, only the “Affirmation Text” box is selected, and it cannot be unchecked 
since it is mandatory. However, the affirmation text can be edited according to your 
requirements. Also, you can choose to enable or disable the “Compliance Text” and 
“Agreement Text” screens and can edit the corresponding text. If all of the options 
are selected, during the act-of-signing, the screens are displayed in the following 
order: 

 

1. “Agreement Text” screen containing “Decline” and “Accept” buttons 
2. “Compliance Text” screen containing “Opt-out” and “Proceed” buttons 
3. “Affirmation Text” screen where the affirmation text is displayed along with 

“OK”, “CLEAR”, and “CANCEL” buttons (including an area of signing) 

 
If the option “Enable compliance text options” is selected in the “Desktop 
Configuration” window, the above screens are displayed for every signature capture in 
all the IntegriSign Desktop plug-ins. 
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2.2 – Creating User Profiles 
 

User profiles can be created using “Create” option available in the “IntegriSign 
Desktop Preferences” window. Enter details like signer name, organization unit, 
organization name, email, etc. Only the “Signer” name field is mandatory. 

 

 

2.2.1 – Public Signing 
 

In public signing (e.g. customer signing), the signer can enter a name in the “Signer 
Name” field and start signing using an ePad device. The “Auto Select Signer Name 
from List” option in the “Desktop Configuration” window has to be unchecked for 
public signing in case a profile already exists. 
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3.0 – Steps for Configuring the Certificate Selection and User 
Profile Creation 

1. A digital certificate is required for signing in Acrobat 10.0 and later. The 
certificate can be self-signed or from a trusted CA (Certificate Authority). If 
you don’t already have a certificate for signing, follow these steps to import a 
certificate: 

i. Navigate to the IntegriSign Desktop installation folder (typically 
“C:\Program Files (x86)\IntegriSign Desktop\Desktop” for a 64-bit OS or 
“C:\Program Files\IntegriSign Desktop\Desktop” for a 32-bit OS) and 
select the certificate (for example, the certificate named 
pdocsignerTopaz.pfx is installed as part of the installation) and double-
click on it. 

ii. Select the "Current User" option under “Store Location”, and click on the 
"Next" button in the displayed “Certificate Import Wizard” window. 

iii. Click on the "Next" button in the displayed “Certificate Import Wizard” 
window. 

iv. Enter the password (for example, the password for the certificate 
pdocsignerTopaz.pfx is “43p4gL7Rn9N7”), and click the "Next" 
button in the displayed “Certificate Import Wizard” window. 

v. Make sure that the "Automatically select the certificate store based on 
the type of certificate" option is selected and click the "Next" button in the 
displayed “Certificate Import Wizard” window. 

vi. Click the "Finish" button in the displayed “Certificate Import Wizard” 
window. 

vii. Click the "OK" button in the displayed message. 
2. Invoke the “IntegriSign Desktop Configuration” window from the following 

location: “Start - Programs - IntegriSign Desktop - Desktop - Desktop 
Configuration”. 

3. In the “Certificate Selection” sub-window, click the “Select” button. 

4. In the "IntegriSign – Certificate Manager" window, select the certificate to be 
used when signing (for example, the certificate value 
“pDocSigner” corresponds to the pdocsignerTopaz.pfx certificate installed 
previously), then click the “OK” button. 

5. Invoke the “IntegriSign Desktop – Preferences” window from the following 
location: “Start - Programs - IntegriSign Desktop - Desktop - Preferences 
Manager”. 

6. Create the “User Profile” in the “Preferences Manager” window. 
 
Note: Expired certificates are not shown in the "IntegriSign – Certificate Manager" 
window. 

mailto:pdoc1@topazsystems.com
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4.0 – Steps for Signing in Adobe Acrobat 

 
4.1 – Creating a Signature in Adobe Acrobat Professional 10.0 

 

Signing in Adobe Acrobat Professional 10.0 can be accomplished in the following 
ways: 

 

4.1.1 – Signing a New Signature Field 
 

1. Open the PDF document to be signed. 
2. Click on the “Tools” button, and then click on the “Sign & Certify” pane item in 

the “Tools” task pane. 
3. Click “Place Signature” or “Sign Document” and then using the mouse, click 

and drag to draw the area where you would like the signature to appear in 
your document. 

4. Start signing in the displayed signature window. 

 

4.1.2 – Placing an Empty Signature Field 
 

1. Open the PDF document to be signed. 
2. Click on the “Edit” button under the “Forms” menu in the “Tools” task pane. 

i. If the opened PDF does not contain any prior form fields, you will receive 
a message saying “Currently there are no form fields in this PDF. Do you 
want Acrobat to detect form fields for you?”. Click on the “Yes” button. 
You will receive a message that “No new form field annotations were 
detected”. Click on the “OK” button and “Design Mode” will be enabled. 

ii. If the PDF contains form fields, you will not receive any messages and 
will be taken directly to “Design Mode”. 

3. In “Design Mode”, either click on the “Forms - Tasks - Add New Field” and 
then select “Digital Signature”, or click on the “Add a digital signature” button 
in the toolbar. 
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4.2 – Signing in Adobe Acrobat Reader 10.0 
 

Signing in Adobe Acrobat Reader 10.0 can be accomplished in the following ways. 
 
Note: The PDF document must be rights-enabled before signing the signature in the 
Adobe Acrobat Reader 10 application. 

 

4.2.1 – Signing a New Signature Field 
 

1. Open the PDF document to be signed. 
2. Click on the “Tools” tab, and then click on “Place Signature” or “Sign 

Document” in the “Tools” task pane. 
3. Click and drag to draw the area where you would like the signature to appear 

in your document. 
4. Start signing in the displayed signature window. 

 

4.2.2 – Signing an Existing Signature Field 
 

1. Open the PDF document which already has blank signature fields in the 
document. 

2. Click on the signature field in the document. 
3. Start signing in the displayed signature window. 

 

4.2.3 – Signing in Enable Protected Mode 
 

In Adobe Acrobat Reader 10.0, by default, the "Enable Protected Mode at Startup" 
option under “Edit - Preferences - General - Application Startup" should be in 
enabled mode. 

 
When you try to sign a signature when this setting is on, after clicking on the “OK” 
button in the Signature Capture window or on the signature capture device, you will 
be prompted with the “Save As” screen. Once the document is saved, the signature 
is applied to the document. If “Enable Protected Mode at Startup” is disabled (i.e., 
unchecked), the signature gets applied to the PDF document without the “Save As” 
prompt and the document gets saved. 
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4.3 – Creating a Signature in Adobe Acrobat Professional 11.0 
 

Signing in Adobe Acrobat Professional 11.0 can be accomplished in the following 
ways. 

 

4.3.1 – Signing a New Signature Field 
 

1. Open the PDF document to be signed. 
2. Click on the “Tools” button, and then click on the “Sign & Certify” pane item in 

the “Tools” task pane. 
3. Click “Place Signature” or “Sign Document” and then using the mouse, click 

and drag to draw the area where you would like the signature to appear in 
your document. 

4. Start signing in the displayed signature window. 

 

4.3.2 – Placing an Empty Signature Field 
 

1. Open the PDF document to be signed. 
2. Click on “Edit” button under the “Forms” menu in the “Tools” task pane. 

i. If the opened PDF does not contain any prior form fields, you will receive 
a message saying “Currently there are no form fields in this PDF. Do you 
want Acrobat to detect form fields for you?”. Click on the “Yes” button. 
You will receive a message that says “No new form field annotations 
were detected”. Click on the “OK” button, and “Design Mode” will be 
enabled. 

ii. If the PDF contains form fields, you will not receive any messages and 
will be taken directly to “Design Mode”. 

3. In “Design Mode”, either click on “Forms - Tasks - Add New Field” and then 
select “Digital Signature”, or click on “Add a digital signature” button in the 
toolbar. 

4. Using the mouse, click and drag to draw the area where you would like the 
signature to appear on your document. Right click on the newly inserted 
signature field and then select “Properties”. 

5. The “Digital Signature Properties” window is now displayed. Enter an 
appropriate name in the “General” tab. In the “Appearance” tab, you can set 
the details like font, text color, borders, and more. 
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4.4 – Signing in Adobe Acrobat Reader 11.0 
 

Signing in Adobe Acrobat Reader 11.0 can be accomplished in the following ways. 
 
Note: The PDF document must be rights-enabled before signing the signature in the 
Adobe Reader 11 application. 

 

4.4.1 – Signing a New Signature Field 
 

1. Open the PDF document to be signed. 
2. Click on the “Sign” tab, and then click on “Place Signature” in the “Sign” task 

pane. 
3. Click on the “Next” button in the displayed confirmation message. 
4. Click and drag to draw the area where you would like the signature to appear 

on your document. 
5. Start signing in the displayed signature window. 

 

4.4.2 – Signing an Existing Signature Field 
 

1. Open the PDF document which already has blank signature fields in the 
document. 

2. Click on the signature field in the document. 
3. Start signing in the displayed signature window. 

 

4.4.3 – Signing in Enable Protected Mode 
 

In Adobe Acrobat Reader 11.0, by default, the "Enable Protected Mode at Startup" 
option under "Edit - Preferences - Security (Enhanced) - Sandbox Protections" 
should be in enabled mode. 

 
When you try to sign a signature when this setting is on, after clicking on the “OK” 
button in the Signature Capture window or on the signature capture device, you will 
be prompted with the “Save As” screen. Once the document is saved, the signature 
is applied to the document. If “Enable Protected Mode at Startup” is disabled (i.e., 
unchecked), the signature gets applied to the PDF document without the “Save As” 
prompt and the document gets saved. 
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4.5 – Creating a Signature in Adobe Acrobat Pro DC 
 

Signing in Adobe Acrobat Pro DC can be accomplished in the following ways. 

 

4.5.1 – Signing a New Signature Field 
 

1. Open the PDF document to be signed. 
2. Click on the “Tools” tab, click on “Certificates” and then click on “Digitally 

Sign” (in the top toolbar). 
3. Click and drag to draw the area where you would like the signature to appear 

in your document. 
4. Start signing in the displayed signature window. 

 

4.5.2 – Placing an Empty Signature Field 
 

1. Click “Tools” and then “Prepare Form”. Select the document you wish to sign, 
and then click the “Start” button. 

2. Near the top of the window, click the “Add a digital signature” button. 
3. Place the signature field where you would like the signature to appear in your 

document and drag the signature field to the desired size using the mouse. 
After doing so, name the signature field, check if it needs to be a “required 
field”, and exit out of the signature box by clicking anywhere on the PDF. 

4. Click the “X” in the “Prepare Form” menu to exit out of the “Prepare Form” 
mode. 
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4.6 – Signing in Adobe Acrobat Reader DC 
 

Signing in Adobe Acrobat Reader DC can be accomplished in the following ways. 

 

4.6.1 – Signing a New Signature Field 
 

1. Open the PDF document to be signed. 
2. Click on the “Tools” tab, click on “Certificates” and then click on the “Digitally 

Sign” (in the top toolbar). 
3. Click and drag to draw the area where you would like the signature to appear 

in your document. 
4. Start signing in the displayed signature window. 

 

4.6.2 – Signing an Existing Signature Field 
 

1. Open the PDF document which already has blank signature fields in the 
document. 

2. Click on the signature field in the document. 
3. Start signing in the displayed signature window. 

 

4.6.3 – Signing in Enable Protected Mode 
 

In Adobe Acrobat Reader DC, by default, the "Enable Protected Mode at Startup" 
option under "Edit - Preferences - Security (Enhanced) - Sandbox Protections" 
should be in enabled mode. 

 
When you try to sign a signature when this setting is on, after clicking on the “OK” 
button in the Signature Capture window or on the signature capture device, you will 
be prompted with the “Save As” screen. Once the document is saved, the signature 
is applied to the document. If “Enable Protected Mode at Startup” is disabled (i.e., 
unchecked), the signature gets applied to the PDF document without the “Save As” 
prompt and the document gets saved. 
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5.0 – Document Verification in Adobe Acrobat 

Right-click on the signed signature in the document. Acrobat 10.0, Acrobat 11.0 and 
Acrobat DC will display a window with the following options: 

 

 
Clear Signature Field: Clears the signature field. 

 

Validate Signature: IntegriSign for Acrobat checks to see if the document and the 
signature have been altered after signing. 

 
View Signed Version: IntegriSign for Acrobat displays a window that shows the 
version of the file that existed at the time of signing. 

 
Compare Signed Version to Current Document: If a document is signed more 
than once, IntegriSign for Acrobat maintains all of the signed versions in a single 
Adobe PDF file. The earlier versions can be compared with the current document 
with this option. 

 
Properties: Clicking on this option shows a window with the image of the signature, 
ePad device information, and the signer information. 
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6.0 – Steps for Signing in Microsoft Excel 

When IntegriSign Desktop is installed onto a system, the plug-in for MS Excel 
2010/2013/2016/2019/2021 is automatically installed. On opening the application, 
you will be able to find the IntegriSign options under the “IntegriSign” menu, as 
shown below: 

 

 
6.1 – Macro Security Settings 

 

1. Click on the “Developer” tab. 
 

Note: If the “Developer” tab isn’t visible, see the next page for instructions. 
 

2. Click on the “Macro Security” button (i.e. “Yellow Exclamation” button) under 
the “Code” group. For reference, see the image below. 

 

 
3. IntegriSign macros are digitally signed. Change the setting to “Disable all 

macros except digitally signed macros”, as shown below. 

 
4. Once the above setting is applied, restart MS Excel. 
5. You might be prompted with a message bar saying “Security Warning ActiveX 

controls have been disabled” with an “Enable Content” button. Simply click on 
the button to proceed further. 
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Note: If the “Developer” tab is not visible, follow the steps below to enable the tab: 
 

1. Open the “Excel Options” window using “File - Options”. 
2. Select the “Customize Ribbon” option on the left side of the “Excel Options” 

window. 
3. Check the "Developer" option in the list under the "Customize the Ribbon" 

section.Click on the “OK” button to finalize. 
 
See the below screenshot for reference. 
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6.2 – Creating a Signature 
 

Signing in MS Excel using IntegriSign can be accomplished by using the 
“Sign Document” option. 

 

 
1. Make the entries in the Excel Sheet and compose the workbook. 
2. Create sheets, depending on requirement (for more information, see the 

Sheet-wise Signing section below). 
3. Place the cursor on the Sheet that requires a signature and click on the “Sign 

Document” button. 
4. An “Authenticate” window is displayed which presents the signer with the 

option of authenticating a specific sheet or the entire workbook. 
5. Choose single or multiple sheets for workbook authentication. 
6. Click “OK” to place a signature placeholder with the words “Double-click to 

Sign”. Double-click this placeholder to sign the sheet. 
7. The signature capture screen is now displayed to capture inputs from the 

ePad. 
 

 
8. Select the “Signer” name from the list for a registered signer, or for public 

(non-registered) signing, the signer can just enter their name in the “Signer 
Name” field. 
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9. Sign using the ePad. The signature trace is shown in the signature 
placeholder. To apply the signature to the document, click on the “OK” button. 
To clear the signature, click on the “Clear” Button. To cancel signing, click on 
the “Cancel” button in the dialog displayed. 

 
In addition to the basic functions mentioned in the Introduction, the IntegriSign MS 
Excel Plug-In also offers sheet-wise signing and workbook verification. 

 

6.3 – Sheet-wise Signing 
 

The IntegriSign MS Excel Plug-in allows you to create multiple sheets in a workbook 
such that each sheet is treated as an independent workbook. This is especially 
useful in cases where the same Excel sheet/workbook is being signed by multiple 
signers and should permit a second or third signer to add comments without 
affecting the first signer’s signature. For example, the first signer (e.g. John) can 
create a sheet and authenticate it with his signature and forward it to the second 
signer (e.g. Nancy), who can then add her comments to the second sheet and 
authenticate it with her signature and so on. 

 

6.4 – Workbook Verification 
 

1. Double-click on the signature in the sheet. 
2. A window is displayed with the image of the current signature, “Signature 

Capture Device” information, and the signer information. 
3. If the sheet is modified after signing, then the signature on the sheet is 

invalidated with an “X” on the signature. Restoring the changes made to the 
sheet brings back the signature to its original state. 

 

6.5 – Microsoft Excel Troubleshooting 
 

Before you begin signing in Excel, you must ensure that you exit design mode by 
clicking on the “Design Mode” icon in the “Developer” tab. 

 

 
Note: Without exiting design mode, you will be unable to use IntegriSign Desktop. 
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7.0 – Steps for Signing in Microsoft Word 

When IntegriSign Desktop is installed onto a system, the plug-in for MS Word 
2010/2013/2016/2019/2021 is automatically installed. On opening the application, 
you will be able to find the IntegriSign options under the “IntegriSign” menu, as 
shown below: 

 

 
7.1 – Macro Security Settings 

 

1. Click on the “Developer” tab. 
 

Note: If the “Developer” tab isn’t visible, see the next page for instructions. 
 

2. Click on the “Macro Security” button (i.e. “Yellow Exclamation” button) under 
the “Code” group. For reference, see the image below. 

 

 
3. IntegriSign macros are digitally signed. Change the setting to “Disable all 

macros except digitally signed macros”, as shown below. 

 
4. Once the above setting is applied, restart MS Word. 
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Note: If the “Developer” tab is not visible, follow the steps below to enable the tab: 
 

4. Open the “Word Options” window using “File - Options”. 
5. Select the “Customize Ribbon” option on the left side of the “Word Options” 

window. 
6. Check the "Developer" option in the list under the "Customize the Ribbon" 

section. 
7. Click on the “OK” button to finalize. 

 
See the below screenshot for reference. 
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7.2 – Authenticate and Secure Signatures 
 

The “Authenticate and Secure” window gives you the option of authenticating a 
specific section within the current document or the entire document for the current 
signature. The “Whole Document” option, when checked, includes the entire 
document for authentication. 

 

 
The “Authenticate and Secure” window is not shown during signing process by 
default. To enable this window, uncheck the “Do not show Authenticate and Secure 
window” under “Word – Configuration”. This can be accessed from the “IntegriSign 
Configuration” menu. The “Freeze Document” option in IntegriSign for MS Word – 
Configuration is irreversible. Once a document is frozen, using this option cannot be 
unfrozen. 

 

 
The document can be authenticated automatically in either “Save” or “Print” events. 
These events can be set from “IntegriSign – Configuration”. 
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7.3 – Freezing a Document 
 

The IntegriSign plug-in allows you to choose if you want to “freeze” the whole 
document from the “Authenticate and Secure” window. Freezing is accomplished 
through the act of signing, immobilizes the whole document, and does not allow any 
changes or modifications to be made. You are required to give a password when 
using the “Freeze” feature. Frozen documents can be unfrozen from “Developer 
Restrict Editing - Stop Protection”. 

 

 
7.4 – Signing Protected Documents and Templates 

 

Before protecting the document to be signed, click “Insert Signature Field” to place a 
signature placeholder in the Word document. Then, protect the document using the 
“Protect Document” feature from the “IntegriSign” menu so that you can sign at a 
later point of time. If the document is protected using the “Restrict Editing” option in 
the “Developer” menu, signing the document with the content authentication feature 
is not possible. 

 
 

 
Place a signature placeholder in the Word document, and then protect the 
document. Select “Forms” from the “Protect documents for…” menu. Provide a 
password to complete the protection of the document process. To unprotect, go to 
“Developer - Restrict Editing - Stop Protection”. 
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To initiate the act-of-signing on unsigned placeholders/fields in a protected 
document, use the “Sign Signature Field” option instead of double-clicking the 
placeholder. The “Sign Signature Field” option displays a window listing all the 
unsigned signature fields. 

 
In our example below, the document has three unsigned signature fields. When 
Signature1 is selected, the selected signature is automatically highlighted in the 
document. Click on the “Sign” button to initiate the act-of-signing. 

 

 
Note: In a protected document: 

 
1. Blank signature fields in the Header/Footer cannot be signed using the “Sign 

Signature Field” option. 
2. Signatures in the Header/Footer do not get verified when the “Verify All 

Signatures” option is used. 
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7.5 – Creating a Signature 
 

Signing in MS Word using IntegriSign can be accomplished by using the “Insert 
Signature Field” option. 

 

1. Compose the document. 
2. Create sections, if desired (for further details on how to create sections in 

Word, see Sectional Signing later in this document). 
3. Place the cursor where the signature needs to be placed on the document, 

and click on the “Insert Signature Field” button. A placeholder appears on the 
document with the words “Double-click to Sign”. Double-click this 
placeholder to sign the document. 

4. The “Authenticate and Secure” window displays, which presents the signer 
with the option of authenticating a specific section within the current 
document or the entire document. 

5. Choose the sections to be authenticated. You may select one or more 
sections depending on how many sections you wish to authenticate with that 
signature. 

6. You also have the option of freezing the entire document preventing any 
further modifications. Freezing an entire document will disable all editing 
features for the document and cannot be reversed. 

7. The signature capture screen is now displayed to capture inputs from the 
ePad device. 

 

 

8. Select the “Signer” name from the list for a registered signer, or for public 
(non-registered) signing, the signer can just enter their name in the “Signer 
Name” field. 

9. Sign using the ePad. The signature trace is shown in the signature 
placeholder. To apply the signature to the document, click on the “OK” 
button. To clear the signature, click on the “Clear” Button. To cancel signing, 
click on the “Cancel” button in the dialog displayed. 

 
In addition to the basic functions mentioned in the Introduction, the IntegriSign MS 
Word Plug-In also offers sectional signing and document verification. 
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7.6 – Sectional Signing 
 

The IntegriSign MS Word plug-in allows you to create multiple sections in a 
document such that each section is treated as an independent document. This is 
especially useful in cases where the same document is being signed by multiple 
signers, and should permit a second or third signer to add remarks to any of the 
sections without affecting the first signer’s signature. For example, the first signer 
(e.g. John) can create a section and authenticate it with his signature and forward it 
to the second signer (e.g. Nancy), who can then add her comments to the second 
section and authenticate it with her signature, and so on. 

 
To create sections in MS Word, follow the steps below: 

1. Go to “View” on the MS Word toolbar and click on “Draft”. 
2. Place the cursor at the location where the section break is required. 
3. Go to the “Page Layout” toolbar and select “Breaks”. 
4. Select the type of section break to be inserted, e.g “Continuous” (if the section 

breaks are intended to be on the same page). 
5. A section break is shown on the document where the cursor was located. 

 
The document can be partitioned into any number of sections. Each section in a 
document is treated independently and can be signed and authenticated, 
depending on the functionality intended for the document. 

 

7.7 – Document Verification 
 

1. Double-click on the signature in the document. A window is displayed with 
the image of the current signature, as well as device and signer information. 

2. If the document is modified after signing, then the signature on the document 
is invalidated with a large “X” through the signature. Reversing the change 
made to the document brings the signature back to its original state. 

 
In case of protected documents, for document verification use the “Verify All 
Signatures” option. Any modifications made to the document after signing will 
invalidate the signatures made. 

 

7.8 – Microsoft Word Troubleshooting 

 

7.8.1 – Text with Special Effects 
 

For optimum performance, we advise that you do not place a signature object next to 
text with special effects, such as strikethrough, superscript, subscript, shadow, and 
more. 
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7.8.2 – Auto-Text Fields 
 

Using IntegriSign along with some of the auto-text fields in a Word document's 
“Header and Footer” are not supported. Using such fields will update the document 
content over time, thus modifying the signature and making it invalid. Use of the 
following auto-text fields with IntegriSign is not recommended: 

 
1. Author 
2. Page # 
3. Date 
4. Confidential 
5. Last printed 
6. Page X of Y 

 

Note: In some cases, inserting the signature placeholder can alter the Table of 
Contents (e.g. page numbers might change). Signing without regenerating the Table 
of Contents and saving the document will invalidate the signature. It is advisable to 
regenerate the Table of Contents after placing all the signature placeholders. Then, 
save the document before signing. 

 

 


